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第1章 緒言

有限温度での物性を計算により求めることは，実用上非常に必要である．第一
原理計算は元来原子の振動のない基底状態における物性を求める手法と考えられ
てきた．ところが実用材料は有限温度，すなわち原子が振動する状態で用いられ
る．このとき熱膨張，比熱，電気伝導率などの諸物性は有限温度において振動の
影響を大きく受ける．そのため有限温度での物性を計算により求めるには，振動
の効果を取り入れて計算することが必要となる．今日の計算機の目覚ましい発展
により，振動の効果を取り入れて計算することが可能となっている．自由エネル
ギーを求める手法として F=H-TS から，エンタルピー:H，エントロピー:S，の２
項に分けて計算を行っている．そこで，そのエントロピー項に振動の効果を考慮
することにより，有限温度での物性の計算が可能になる．現在まで西谷研究室に
おいてはエンタルピーは第一原理計算により，エントロピー項は phonon-DOS法
を用いて，振動効果を含む自由エネルギーを計算して来た．しかし，複雑な多形
を多く計算する際，phonon-DOS法では計算量が多く時間がかかってしまい，実
用的ではなかった．そこで，本研究では 3C,4H,6H及び 2H-SiC多形と ZrCr2Laves

相の各構造計算に対し，このエントロピー項計算を E-V(Energy-Volume)曲線か
ら，状態密度関数を近似し，それを積分することにより計算する簡便法を提案し，
実験値とより精度の高い phonon-DOS法と比較することで，その信頼性を調べた．
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第2章 計算原理

この章では，擬調和振動子近似である phonon-DOS法からの熱振動効果を含ん
だ自由エネルギー計算と E-V曲線から簡便法を用いた，熱振動効果を含んだ自由
エネルギー計算の計算原理を紹介する．

2.1 結晶構造の作成
MedeAというソフトウェアを使って結晶モデルを作成する．MedeAはデータ
ベースと第一原理計算の手法を１つのプラットフォームで統合した，材料設計支
援のための統合ソフトウェアである．グラフィックスインターフェースおよび計算
プログラムは全てWindowsシステム上で稼働するので，構造の検索，構築，編集，
計算，解析までを１つのプラットフォーム上で行うことができる [1]．

2.2 phonon-DOS法
今日の第一原理計算は振動効果のない状態，すなわち絶対零度での計算となっ
ている．しかしながら，熱膨張率，比熱，電気伝導率などの諸物性は有限温度に
おいて熱振動の影響を受ける．そのため，有限温度での物性を計算により求める
ことは，熱振動の効果を取り入れて計算する事が必要となる．また，今日の計算
機のめざましい発展により，熱振動の効果を取り入れて計算する事が可能となっ
ている．
計算の過程でフォノンの分散関係を求める．第一原理法によるフォノンの分散
関係の求め方は大きく分けて２種類ある．１つ目はスーパーセルを用いない linear

response method，もう１つはスーパーセルを用いる direct methodである．本研
究は後者の direct methodを用いて計算した．

2.2.1 格子定数の計算のながれ

格子定数を求める計算は，おおまかには次のような手順をふむ．

1. 第一原理計算ソフトは VASP[2](Vienna Ab-initio Simulation Package)を用い
て結晶の静止エネルギー (振動していないときの格子の持つエネルギー)およ
び，原子を１つ動かしたときに各々の原子にかかる力を求める．
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2. 動かした原子の移動距離とかかった力より力の定数を求め，それより周波数 ω

と波数 kの関係 (分散関係)を求める．

3. 分散関係よりフォノンの状態密度を求める．

4. 状態密度より振動の自由エネルギーを求め，それに静止エネルギーを足して系
全体の自由エネルギーを求める．

5. 格子の長さを変化させて，１から４を繰り返す．そして，各温度で自由エネル
ギーを格子の長さについてプロッットし，自由エネルギーが極小値をとると
きの格子の長さをその温度における計算上の平衡な格子定数とする．

以下さらに詳しく説明していく．

2.2.2 平面波基底擬ポテンシャル法

密度汎関数に基づく第一原理擬ポテンシャル法によるバンド計算VASP codeを
用いて計算を行う．この手法では，３次元周期境界条件を満たす平面波の基底関
数を用いて，電子被占有の軌道を展開し，その波動関数をもとに１電子方程式を
解く事により電子状態を求める．交換相関ポテンシャルは GGA(generalized gra-

dient approximation)を用いた．そして，擬ポテンシャルとして PAW(projector

augmented wave)を用いた．

2.2.3 VASP(VIENNA Ab-initio Simulation Package

VASPは平面波擬ポテンシャル法 (ならびにPAW法)による第一原理バンド計算
プログラムである．平面波基底の重ね合わせで波動関数を表現し，密度汎関数理論
に基づいて電子状態の計算を行う．平面波を使用する利点として，その系の原子に
かかる力の計算を正確かつ高速に行える点が挙げられる．このことから，VASPは
構造最適化や第一原理分子動力学計算のツールとして幅広く用いられている．ま
た，擬ポテンシャル法により内殻電子をポテンシャルに置き換えて取り扱うので，
波動関数の表現に用いる平面波基底の数を大幅に減らし，計算量を軽減する．内
殻電子の取り扱いについては，擬ポテンシャル法の他に，全電子計算PAW法を採
用しており，擬ポテンシャル法と比べてさほど計算量を増やす事なく，精度を上
げる事ができる．バルク構造，表面，界面など多岐に渡る問題に適用できる汎用
的なソフトウェアである．また，VASPの計算を実行するために必要なファイルが
がどのような入力を担うかを簡単に記しておく．詳しくは附録を参照せよ．
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INCAR

計算を制御するための入力パラメータが収められているファイル．VASPの中
心となるファイルで，VASPをどのように何をさせるか決めるものである．この
ファイルを扱うときにはエラーや失敗の元となるので気をつけなければならない．

KPOINTS

波動関数を波数空間上 (k-空間)で展開する際に，どのくらいの刻み幅にするか
を指定するためのファイルで，計算の精度に直接関わる．詳しくは附録を参照．

POSCAR

計算モデルの格子定数 (primitive vectors)と原子座標 (lattice coordinates)が収
められている．

POTCAR

計算に使用されている各元素の原子核ポテンシャルが収められている．大きな
ファイルなので，閲覧する際は more,headや grep等のコマンドを用いたほうが
よい．

2.2.4 PAW(Projector Augmented Wave)法

擬ポテンシャル法としてPAW法を用いた．擬ポテンシャル法には，フルポテン
シャル · PAWポテンシャル · (ウルトラソフト型)擬ポテンシャルの３つに分類さ
れる．PAWポテンシャルは Blochlが考案した全電子計算の方法で，フルポテン
シャルの精度と擬ポテンシャルの高速性の両者を兼ね備えた方法で，それぞれの
特徴を表に示す [1]．

フルポテンシャル ◦ 精度が高い
◦ 全元素対応
× 計算時間がかかるため，小さな系のみ
× 原子半径等，パラメータ設定に熟練が必要

PAW法 ◦ フルポテンシャルの精度を維持しながら計算時間を軽減
◦ 全元素対応

(ウルトラソフト型) ◦ 計算時間を軽減
× アルカリ金属，アルカリ土類，希土類に難
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2.2.5 力の定数 [3]

力の定数の求め方は１次元調和振動子を例にすると，力の式は次のように示さ
れる．

F = −Cu (2.1)

ここで，F は力，Cは力の定数，uは動かした距離を表す．このように，力の値と
動かした距離がわかれば力の定数Cの値が求められる．３次元でも基本的に求め
方は同じであるが，力の式は次のように示される．

F = −
∑

l

Cl · u (2.2)

力F および動かした距離 ulはベクトル，力の定数Clは 3× 3の行列となっている．
また lは原子の番号をあらわす．この（2.2式）より，力の定数の値を求める．

図 2.1: １次元調和振動子の簡易なモデル．

2.2.6 分散関係 [4][5]

まず例として１次元のバネモデルから分散関係を求める (図 2.2)．ある時刻 tに
おいて n番目の原子の平衡位置からの変位を unとする．n番目の原子に働く力を
考えると運動方程式は次のように示される．

M
∂2un

∂t2
= C (un+1 − un) − C (un − un−1) (2.3)

この式に次のような進行波の解

un = A exp [i (ωt − kna)] (2.4)
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を代入すると式 (2.3)は次のように変形できる．ただし，Aは振幅，aはバネの長
さを表す．

−Mω2un = −4Cun sin
(

1

2
ka

)
(2.5)

... ω =

√
4C

M

∣∣∣∣sin (
1

2
ka

)∣∣∣∣ (2.6)

式 (2.6)を波数 kについてプロットすると，図 2.3のようになる．

図 2.2: １次元バネモデル．

３次元の場合についてもほぼ同様の計算を行う．原点での運動方程式は

m
∂2u0

∂t2
= −

∑
l

Cl · ul (2.7)

であり，この式に平面波の解として

ul (k) = A exp [i (k · rl − ωt)] (2.8)

を代入すると，
mω2A =

∑
l

·A exp [ik · rl] (2.9)

さらに，ダイナミカルマトリックスを次式で定義する．

D (k) =
1

m

∑
l

Cl · exp (ik · rl) (2.10)

式 (2.10)を用いると，式 (2.8)は次のようなものとなる．

ω2A = D (k) · A (2.11)
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D (k)は 3 × 3の行列，Aはベクトルとなっている．すなわち３次元では固有値問
題となっていて，ダイナミカルマトリックスの固有値を求める事により波数 kと
周波数 ωの分散関係が求められる．ただし，３次元分散曲線では横波と縦波が存
在するため，曲線は複数個存在する．

図 2.3: １次元の第一ブリルアンゾーン内の分散曲線．

2.2.7 状態密度

フォノンの分散関係がわかれば，フォノンの状態密度が求められる．フォノン
の周波数が ω と ω + dωの間にある可能な kの数は

D (ω) dω =
(

L

2π

)3 ∫
shell

d3k (2.12)

となる．Lは立方体の一辺の長さを表す．積分は，k空間において，フォノンの周
波数が一定の値ωをとる表面とω + dωとの間にはさまれた殻上の体積にわたって
行う．ここで，k空間のある一定の周波数 ωの面上の面積素片を dSωとすると∫

shell
d3k =

∫
dSωdK⊥ (2.13)

であり，dK⊥は ω一定の面と ω + dωの面との垂直距離である．また，ωの勾配
▽kω も ωが一定の面に垂直だから，

|▽kω| dK⊥ = dω (2.14)

7



したがって，体積素片は

dSωdK⊥ = dSω
dω

|▽kω|
= dSω

dω

vg

(2.15)

ただし vgはフォノンの群速度である．V = L3を用いると，式 2.12は

D(ω) =
V

(2π)3

∫ dSω

vg

(2.16)

となりフォノンの状態密度が求められる．

図 2.4: フォノン状態密度．

2.2.8 自由エネルギー

自由エネルギーは次式によって与えられる．

F (a, T ) = Estat(a) +
∫ ωmax

0
D(ω)f(ω, T )dω (2.17)

ここでaは格子の長さをあらわし，Tは温度をあらわす．また，右辺第一項のEstat(a)

は静止エネルギー，すなわち振動していないときに格子が持つエネルギーをあらわ
し，右辺第二項は振動の自由エネルギーをあらわす．また，右辺第二項の f(ω, T )

はフォノン一個あたりの自由エネルギーをあらわし，次式で定義される．

f(ω, T ) = kT ln

[
2sinh

(
hω

4πkT

)]
(2.18)

式 (2.17)を用いてある格子定数のもとでの各々の温度における自由エネルギーを
求める．ただし，kはボルツマン定数，hはプランク定数をあらわす．
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2.2.9 格子定数

式 (2.17)の右辺第一項は格子の長さに依存し，格子の長さに対して単調に増加
する関数となる．また，フォノンの状態密度D(ω)が格子の長さに依存する．その
ため，右辺第二項は温度を一定にすると，格子の長さに対して単調に減少する関
数となる．
よって式 (2.17)の右辺第一項と第二項を足し合わせることにより，極小値が得
られる．そして，自由エネルギーが極小値をとるときの格子の長さをその温度で
の計算上の格子定数とする．

2.2.10 熱膨張

熱膨張率とは温度の上昇によって物体の長さ ·体積が膨張する割合を，1K当た
りで示したものである．特に，体積の変化する割合を体積膨張率といい，固体の
体積膨張率 β，物体の体積 V , 温度Tを用いて次のように定義される．

β =
1

V

dV

dT
(2.19)

2.3 E-V曲線から簡便法を用いた有限温度の第一原理
計算 [6]

結晶の E-V曲線を求める計算は第一原理計算の基本的な計算ではあるが，重要
な物性を与えてくれる．その一つに，結晶の硬さの指標となる体積弾性率を求め
る事ができる．その体積弾性率から，有限温度における，熱振動効果を含む自由
エネルギー，熱膨張を考慮した体積増加率，体積熱膨張率を計算で求めていく．
まず，E-V曲線の体積を原子間距離 rに変数変換し，

E (r) = a + br + cr2 + dr3 + er4 (2.20)

に fittingさせる．ここで a,b,c,d,eは適当な定数である．また，圧力 P，体積弾性
率Bは次のように定義される．

P = −dE

dV
,B = −V

dP

dV
(2.21)

また，体積Vを適当な定数Aを用いて

V = Ar3 (2.22)

と定義すると，体積弾性率B (r)は

B (r) =
r

3

d

dr

(
1

3Ar2

dE

dr

)
(2.23)
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で表される．次に自由エネルギー F は原子間距離 rと温度 T の関数として，

F (r, T ) = E (r) + ED (r, T ) − TSD (r, T ) (2.24)

のように定義される．式 (2.24) の右辺第２項，第３項はDebye関数DとDebye温
度 θDを用いて以下のように表せる．

ED (r, T ) = 3kBTD

(
θD

T

)
+ E0 (2.25)

SD (r, T ) = 3kB

[
4

3
D

(
θD

T

)
− ln

(
1 − e−

θD
T

)]
(2.26)

さらに，式 (2.25)の右辺第２項は基底状態のエネルギーを表し，Debye温度 θDを
用いて以下のように表せる．

E0 =
9

8
kBθD (2.27)

したがって，自由エネルギー F (r, T )は次式のようになる．

F (r, T ) = E (r) − kBT

[
D

(
θD

T

)
− 3 ln

(
1 − e−

θD
T

)]
+

9

8
kBθD (2.28)

これで自由エネルギーを求める式が求まった [7]．次に導出過程で出てくる，Debye

関数，Debye温度についてまとめておく．

2.3.1 Debye関数

Debye関数の定義の流れを以下に示す．関数 f (x)を定義する．

f (x) =
exx4

(ex − 1)2 (2.29)

この式を以下の様に積分することで，Debye関数が定義される．

D =
3

y3

∫ y

0
f (x) dx (2.30)

次にDebye関数のプロットを図 2.5に示す．

10



図 2.5: D
(

1
x

)
曲線

2.3.2 Debye温度 θD，Debye振動数 ωD

Debye温度 θD，Debye振動数 ωDの定義の導出過程を以下で示す．Debye温度
とDebye振動数は比例関係にある．まずDebye振動数をフォノンの状態密度関数
より求める．そして，Debye温度とDebye振動数の比例関係からDebye温度を導
出する．最終的に求まる θDは，

θD = 41.63
(

rB

M

) 1
2

(2.31)

である．以下は θDの導出過程である．Debye振動数ωDとDebye温度の関係式は，

h

2π
ωD = kBθD (2.32)

で表される．hはプランク定数 kBはボルツマン定数を表す．次にDebye振動数を
導出するため，フォノンの状態密度関数 g (ω)を定義する．フォノンの状態密度関
数 g (ω)は，

g (ω) =
V ω2

2π2v3
S

　 (2.33)
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として定義される．ここで vS は音速，V は体積を表す．vS はすべての方向にわ
たって平均したものであり，

1

v3
S

=
2

v3
T

+
1

v3
L

(2.34)

と１つの縦波の音響分枝 vLと，２つの横波の音響分枝 vT で表記できる．vSを式
(2.33)に代入すると，

g (ω) =
V ω2

2π

(
2

v3
T

+
1

v3
L

)
(2.35)

となる．これよりまず，状態密度関数から状態総数を求めていく．状態総数は状
態密度関数を積分することにより求まる．この場合，Debye振動数ωDまで積分し
て求める．状態総数 (モードの数)は原子数×次元である．今，１原子，３次元で
考えているので，状態総数は３となり，となる．∫ ωD

0
g (ω) dω = 3 (2.36)

よって式 (2.35)を式 (2.36)に代入して計算すると，

V

6π2

(
2

v3
T

+
1

v3
L

)
ω3

D (2.37)

となり，Debye振動数 ωDが求まった．次に，三個の音響分枝の平均 vを，

2

v3
T

+
1

v3
L

= 3v−3 (2.38)

のように定義する．これは音響分枝 (縦波，横波)を考える事により，振動の効果
を厳密に求めるためである．式 (2.38)を式 (2.37)に代入すると，

V

6π2
v−3ω3

D = 1 (2.39)

となる．ここで V は体積であり，V = 4
3
πr3とする．次ぎに vを定義する．vは密

度 ρと体積弾性率Bで，

v =

(
B

ρ

) 1
2

(2.40)

のように定義される．また密度 ρを定義する．ρは M
V
で定義されるので，

ρ =
M

4
3
πr3

(2.41)

となる．M は原子量を表す．よって ωDは式 (2.39)，式 (2.40)，式 (2.41)より，

ωD =
(
6π2

) 1
3

(
4

3
πr3

) 1
6

(
B

M

) 1
2

(2.42)
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となる．また θDは式 (2.32)の式変形より，

θD =
h

2πkB

ωD (2.43)

と表記され，式 (2.42)，式 (2.43)より，

θD =
h

2πkB

(
6π2

) 1
3

(
4

3
πr3

) 1
6

(
B

M

) 1
2

(2.44)

と導出される．ボルツマン定数 kB = 1.38026× 10−23 [J · K−1]，プランク定数 h =

6.62620 × 10−34 [J · s]より，これらを式 (2.44)に代入して計算すると，

θD = 67.48
(

rB

M

) 1
2

(2.45)

となる．次に縦波の音響分枝 vL，横波の音響分枝 vLをそれぞれ体積弾性率 Bで
あらわし計算していく．まず３つの音響分枝の平均である vを，

v =

[
1

3

(
2

v3
T

+
1

v3
L

)]− 1
3

(2.46)

のように示す．音響分枝を縦波音響分枝 vLの弾性率 Lで表し，

vL =

(
L

ρ

) 1
2

(2.47)

横波の音響分枝 vT を横波音響分枝の弾性率 Sで表すと，

vT =

(
S

ρ

) 1
2

(2.48)

となる．T = 1.42B,S = 0.3Bを式 (2.47)，式 (2.48)に代入し，それを式 (2.45)に
代入して計算すると，

v = 0.617

(
B

ρ

) 1
2

(2.49)

となる．出て来た係数 0.617は３つの音響分枝を考慮した際，出現する vの定数で
ある．音響分枝の弾性率を含んだ vはこの定数により，音響分枝の硬さの概念が考
慮される．よって，この vを用いて，θDを計算する．すなわち，式 (2.45)に 0.617

を掛けると，

θD = 41.63
(

rB

M

) 1
2

(2.50)

となり，式 (2.32)は導出された [7]．

13



2節の参考文献

[1] MedeA 2.0 使用説明書,株式会社,菱化システム,科学技術システム本部計算科
学部．

[2] VASP マニュアル ”http://cms.mpi.univie.ac.at/vasp”．

[3] W.Cochran, 小林正一 福地充 訳, 格子振動 (固体物性シリーズ 3) 丸善．(1966)

[4] C.Kittel,宇野良清　津屋昇　森田章　山下次郎　訳,固体物理学入門　上,丸善．

[5] G.Burns, 小島誠治　澤田昭勝　中村輝太郎　訳, 固体の諸性質, 東海大学出
版会．

[6] J.R. Hook and H.E. Hall 著, 「固体物理学入門」，福山秀敏 監訳，松浦民房，
鈴村順三，黒田義浩 共訳，(丸善 (株)，東京，2002).

[7] V.L.Moruzzi, J.F.Janak and K. Schwarz, ”Calculatedthermalpropertiesofmetals,”

Phys. Rev. B, 37(1998), 790-799.

14



第3章 SiC多形の計算物性

次世代半導体材料として注目されている，SiCの代表的な多形である 3C,2H,4H

及び 6H-SiC多形を対象として，E-V曲線からの簡便法とより精度の高い phonon-

DOS法での有限温度での第一原理計算を行った．そして，体積増加率と振動効果
を含む自由エネルギーの温度依存性の結果を比較し，簡便法の信頼性を調べた．

3.1 比較対象としたSiC多形 [2]

シリコンカーバイド (SiC)はすぐれた物性的特徴から次世代半導体材料として
注目されている．SiC以外の半導体材料ウェーハーは液相からの成長によって低コ
ストで製造されているが，SiCではいまだ確立していない．そこで，関学の金子ら
は SiC単結晶成長法として，準安定溶媒エピタキシー (MSE)を開発した．このプ
ロセスは，図 3.1のように，TaCのるつぼ内に，3C-SiCを原料版 (feed)，4H-SiC

を基板 (seed)とし，その間に液体 Siの薄膜を挟み込んだ構成を取る．そして，温
度は一定に保たれたままで，単結晶成長が進むことが知られている．その際の結
晶成長の駆動力は原料版と基板に用いられた SiC多形の化学ポテンシャルの差で
ある．
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図 3.1: MSEプロセスの模式図．

3.2 E-V曲線
エネルギーの体積依存性を求めた曲線，いわゆるE-V曲線は，第一原理計算の
基本ながら重要な情報を与えてくれる．x軸座標に体積をとり，y軸座標にエネル
ギーをとっている．y軸座標は下にいくほどエネルギーが低くなっている．無限遠
ではお互いが相互作用せず，エネルギー基準としてゼロにとる．そこから距離を
近づける (体積を小さくする)と，お互いが引き寄せ合う．さらに，近づけすぎる
と急激に反発が強くなる．この特徴的な振る舞いは，2原子間の結合を支配する二
つの重要な構成要素を示している．引力と斥力がちょうどつり合う位置で，2原子
は平衡を保つ．この曲線において，極小を取る位置が平衡状態であり，その x座
標の値が各結晶における最安定時の体積となり，y座標の値が結合エネルギーとな
る．図 3.2では 3C,4H,6H及び 2H-SiCとも相安定性の結合エネルギーがほぼ同様
であることが見てとれる．また，この曲線の一次微分は圧力を示し，その傾きは硬
さを示す指標となる．図 3.3は体積で一次微分した図である．4H,6H及び 2H-SiC

はほぼ同じ傾きをとっていますが，3C-SiCは他の多形に比べ，体積が増加するに
つれて硬さが増している．

16



-13.4

-13.6

-13.8

-14.0

-14.2

-14.4

-14.6

-14.8

-15.0

3C
2H
4H
6H

En
er

gy
 [e

V
/S

iC
 a

to
m

s]
Volume [Å3/SiC atoms]

図 3.2: 第一原理計算で求めた SiC多形の E-V曲線．
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図 3.3: 図 3.2を体積で一次微分した曲線．

3.3 phonon-DOS法によるSiC多形の自由エネルギー
一定体積の場合と熱膨張を考慮しての体積変化での熱振動効果を含む自由エネ
ルギーを求めた．
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3.3.1 一定体積の場合

フォノン分散曲線

3C-SiCは 2× 2× 2のスーパーセルであり 4H,6H及び 2H-SiCは 3× 3× 1の
スーパーセルでフォノンの分散曲線を求めた．図 3.4，図 3.5，図 3.6及び図 3.7で
分枝の個数が異なるのは単位格子あたりの原子の数が違うからであり，単位格子
あたり n個の原子があるときには，3n個の分枝が存在することになる．しだがっ
て，3C-SiCは 6個，4H-SiCは 24個，6H-SiCは 36個，2H-SiCは 6個の分枝が存
在する．

表 3.1: 3C-SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

0 11.832 13.652 15.794 21.622 22.663 25.063

0.002 11.83 13.652 15.794 21.623 22.662 25.064

0.004 11.823 13.65 15.794 21.625 22.66 25.065

0.0061 11.811 13.648 15.794 21.629 22.656 25.069

0.0081 11.795 13.645 15.794 21.635 22.65 25.073

: : : : : : :

0.3549 0.406 0.406 0.607 23.061 23.061 23.069

0.3574 0.203 0.203 0.303 23.059 23.059 23.061

0.3599 -0.008 -0.008 -0.008 23.059 23.059 23.059

0.3627 0.238 0.238 0.345 23.058 23.058 23.064

0.3656 0.477 0.477 0.69 23.058 23.058 23.08

: : : : : : :

以下，397点続くが省略する．
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図 3.4: 3C-SiCのフォノン分散曲線．
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表 3.2: 4H-SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5595 0.058 0.067 0.11 5.683 5.7 5.926

0.5604 -0.07 -0.01 0.033 5.689 5.706 5.921

0.5642 -0.372 0.246 0.671 5.702 5.708 5.929

0.568 0.027 0.497 1.12 5.702 5.755 5.94

0.5718 0.597 0.767 1.561 5.699 5.834 5.958

: : : : : : :

1.0583 0.619 0.848 1.679 5.762 5.855 5.988

1.0615 0.231 0.636 1.322 5.731 5.789 5.959

1.0648 -0.363 0.425 0.964 5.709 5.742 5.938

1.0681 -0.396 0.214 0.594 5.694 5.715 5.926

1.0714 -0.07 -0.01 0.033 5.689 5.706 5.921

図 3.5: 4H-SiCの分散曲線．
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表 3.3: 6H-SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5409 0.053 0.057 0.064 4.184 4.204 4.359

0.5415 -0.063 0.039 0.049 4.19 4.21 4.353

0.5453 -0.414 0.239 0.69 4.207 4.216 4.367

0.5491 -0.25 0.476 1.132 4.22 4.268 4.379

0.5528 0.531 0.728 1.56 4.235 4.36 4.4

: : : : : : :

1.0368 0.554 0.839 1.681 4.283 4.393 4.443

1.04 -0.092 0.63 1.331 4.244 4.313 4.405

1.0433 -0.418 0.421 0.978 4.216 4.255 4.377

1.0466 -0.421 0.214 0.61 4.197 4.221 4.36

1.0498 -0.063 0.039 0.049 4.19 4.21 4.353

図 3.6: 6H-SiCのフォノン分散曲線．
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表 3.4: 2H SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.61 0.018 0.045 0.053 7.629 7.632 17.781

0.6138 -0.319 0.242 0.632 7.624 7.64 17.776

0.6176 0.188 0.483 1.069 7.609 7.68 17.763

0.6214 0.591 0.744 1.504 7.586 7.74 17.741

0.6252 0.877 1.035 1.943 7.556 7.823 17.711

: : : : : : :

1.1081 0.689 0.859 1.618 7.682 7.745 17.744

1.1114 0.374 0.645 1.266 7.66 7.695 17.76

1.1147 -0.248 0.431 0.916 7.644 7.659 17.771

1.1179 -0.338 0.217 0.558 7.634 7.637 17.778

1.1212 0.018 0.045 0.053 7.629 7.632 17.781
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図 3.7: 2H-SiCのフォノン分散曲線．

23



フォノン状態密度

フォノンの分散関係から得られた状態密度 [図 3.8]は振動数が 0∼20[THz]の音
響モードでは 3C,4H,6H及び 2H-SiCで共通して低い値で安定している．振動数が
20∼30[THz]の光学モードでは 3C,4H,6H及び 2H-SiCに共通して値が急激に上がっ
たり，下がったりしている．なぜ，3C,4H,6H及び 2H-SiCでは異なる形のフォノン
分散曲線になっているのにフォノン状態密度では似たような形になっているのか．
それは，3C,4H,6H及び 2H-SiCはユニットセルでは原子数や原子配置が異なって
いるが，局所的には Si-Cの結合様式が同様であるからである．

Frequency [THz]
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3C-SiC

図 3.8: SiC多形の phonon-DOS.

熱振動効果を含む自由エネルギー

最終的に求める熱振動効果を含む自由エネルギーは，各々の phonon-DOS関数
[図 3.8]を式 2.17に当てはめて積分する事で得られる．以下に，熱膨張を考慮しな
い，一定体積下での phonon-DOS法で得られた結果を表示させた．
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Cv : vibrational heat capacity at constant volume.

E(T)-E(0) : the change in vibrational internal energy from 0 K.

E(0) is the zero point energy (ZPE).

S(T) : the vibrational entropy at temperature T.

-(A(T)-E(0)) : the change in the vibrational Helmholtz free energy from 0 K.

E(T) : the electronic plus vibrational energy of formation.

A(T) : the electronic plus vibrational Helmholtz free energy.

表 3.5: 3C-SiCの phonon-DOS法での計算結果の数値．
T Cv E(T)-E(0) S(T) -(A(T)-E(0)) E(T) A(T)

K J/K/mol kJ/mol J/K/mol kJ/mol kJ/mol kJ/mol

0 0.0000 0.0000 0.0000 0.0000 -30.1161 -30.1161

100 4.5382 0.1144 1.4893 0.0346 -30.0017 -30.1507

200 16.9247 1.1816 8.3904 0.4965 -28.9345 -30.6126

400 34.5887 6.5658 26.3376 3.9692 -23.5503 -34.0853

800 45.0984 23.0581 54.5058 20.5462 -7.0580 -50.6624

1600 48.6118 60.9838 87.2317 78.5860 30.8677 -108.7021

2000 49.0645 80.5288 98.1332 115.7364 50.4127 -145.8525

2400 49.3133 100.2087 107.1027 156.8364 70.0926 -186.9525

2800 49.4644 119.9664 114.7167 201.2382 89.8503 -231.3543

3000 49.5186 129.8649 118.1313 224.5268 99.7488 -254.6429
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表 3.6: 4H-SiCの phonon-DOS法での計算結果の数値．
T Cv E(T)-E(0) S(T) -(A(T)-E(0)) E(T) A(T)

K J/K/mol kJ/mol J/K/mol kJ/mol kJ/mol kJ/mol

0 0.0000 0.0000 0.0000 0.0000 -30.3941 -30.3941

100 4.4999 0.1140 1.4800 0.0340 -30.2802 -30.4282

200 16.7892 1.1710 8.3146 0.4919 -29.2231 -30.8861

400 34.5041 6.5322 26.1799 3.9397 -23.8619 -34.3338

800 45.0712 23.0051 54.3121 20.4443 -7.3891 -50.8385

1600 48.6046 60.9196 87.0275 78.3235 30.5254 -108.7176

2000 49.0599 80.4622 97.9277 115.3919 50.0681 -145.7861

2400 49.3102 100.1406 106.8965 156.4095 69.7465 -186.8036

2800 49.4622 119.8973 114.5100 200.7289 89.5032 -231.1230

3000 49.5166 129.7953 117.9245 223.9760 99.4012 -254.3701

表 3.7: 6H-SiCの phonon-DOS法での計算結果の数値．
T Cv E(T)-E(0) S(T) -(A(T)-E(0)) E(T) A(T)

K J/K/mol kJ/mol J/K/mol kJ/mol kJ/mol kJ/mol

0 0.0000 0.0000 0.0000 0.0000 -30.0794 -30.0794

100 4.6351 0.1181 1.5333 0.0352 -29.9613 -30.1146

200 16.9741 1.1928 8.4885 0.5049 -28.8866 -30.5843

400 34.6062 6.5827 26.4567 3.9999 -23.4966 -34.0793

800 45.1043 23.0791 54.6325 20.6266 -7.0002 -50.7059

1600 48.6135 61.0074 87.3607 78.7689 30.9280 -108.8482

2000 49.0657 80.5529 98.2625 115.9710 50.4735 -146.0503

2400 49.3142 100.2332 107.2323 157.1226 70.1539 -187.2020

2800 49.4652 119.9913 114.8463 201.5763 89.9119 -231.6557

3000 49.5192 129.8898 118.2610 224.8909 99.8105 -254.9703
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図 3.9: SiCの熱振動効果を含む自由エネルギーの温度依存性．
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図 3.10: 4H-SiCを基準にとった場合の SiCの熱振動効果を含む自由エネルギーの
温度依存性．

図 3.9は 3C,4H,6H及び 2H-SiCの熱振動効果を含む自由エネルギーの温度依存
性を出したものであるが，温度に対して各多形のエネルギー差が極めて小さいこ
とが分かる．そこで，図 3.10は 4H-SiCを基準にして，熱振動効果を含む自由エネ
ルギー差の温度依存性を出したものである．こちらは，温度に対して各多形のエネ
ルギー差があることが見て取れ，低温では 4H-SiC，中間温度∼高温では 6H-SiC

が最も安定なエネルギーを取る．つまり，その変態点である，約 1400Kにおいて，
相変態がおこっていることがわかる．

3.3.2 熱膨張による体積変化を考慮した場合

3.3.1節では体積を考慮しない場合の計算結果を示している．次に，固体の体積
が温度の上昇につれて増加する熱膨張を考慮する．これは熱によって分子運動が
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はげしくなり，分子間距離が大きくなるためである．3.3.1節での体積を 1.0と基
準にし，3C-SiCは立方晶であり c/aが 1:1のため，0.990∼1.03まで 0.0025ずつ増
やした計 17点の体積で計算し，4H,6H,2H-SiCでは c/aを固定させずに，a軸に
1.0∼1.025まで 0.005ずつ増やし，c軸も 1.0∼1.025まで 0.005ずつ増やして計 36

点の体積で計算し，それぞれの温度に対して極小のエネルギーを出している．

フォノン分散曲線

3C-SiCは 2× 2× 2のスーパーセルであり 4H,6H-SiCは 3× 3× 1のスーパー
セルで，2H-SiCは 3×3×2のスーパーセルでフォノンの分散曲線を求めた．表 3.8，
表??での 3C SiCのフォノン分散曲線の Γ点周辺の数値は虚の値がほとんどない．
しかし，表 3.10，表 3.11，表 3.12，表 3.15での 4H,6H-SiCのフォノン分散曲線の
Γ点周辺の数値は体積の倍率を増やすとともに虚の値が増大している．虚の振動
が出る理由は 2つある．1つは計算精度が不十分である．もう一つは構造が不安定
である．計算精度が原因の場合は，精度を上げていくことで分散曲線が改善され
ていくかを確認する必要がある．phononの計算を行うときには，計算に用いる構
造モデルが重要である．phonon計算を行う前に構造最適化を行う．このときに収
束条件を厳しく設定することで計算精度を上げることができる．しかし，今回の
場合は計算精度が原因であると考えるより構造が不安定であるのが原因と考えら
れる．なぜならば，phonon計算を行う前の構造が熱膨張を考慮し体積変化させて
いるため基底状態において最適ではないからである．
安定でない構造のとき虚の振動数がでる理由は単純な 2次元のポテンシャル曲
線で考えると，下に凸 (図 3.11)な場合，その曲線の底がエネルギー最安定な状態
に対応している．この点の振動数を見積もるとき，例えば 2次曲線近似を導入す
ると，エネルギーは次式で定義される．

E = k(r − r0)
2 (3.1)

振動数は次式で表される

ν =
1

2π

√
k

M
(3.2)

kバネ定数であり，kの正負によって振動数 νは正の値あるいは虚の値になる．下
に凸の曲線の場合は kは正であり，振動数 ν も正になる．もし曲線が上に凸 (図
3.11)であるとすると，kは負になり，振動数 νも虚になる．ポテンシャル曲線が
上に凸であるということは，この極点はエネルギーが高い状態にあり，より低い
状態に移行することができる．つまり不安定であることがいえる．
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不安定
安定

(a) (b)

図 3.11: (a) 下に凸の曲線．(b) 上に凸の曲線

表 3.8: 3C-SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.3514 0.406 0.406 0.591 22.299 22.299 22.307

0.3539 0.208 0.208 0.299 22.297 22.297 22.299

0.3563 0.049 0.049 0.049 22.296 22.296 22.296

0.3591 0.24 0.24 0.342 22.296 22.296 22.302

0.362 0.471 0.471 0.678 22.296 22.296 22.318

: : : : : : :

以下 397点続くが省略する．
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表 3.9: 3C-SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.348 0.393 0.393 0.562 21.648 21.648 21.656

0.3504 0.191 0.191 0.277 21.646 21.646 21.648

0.3528 -0.056 -0.056 -0.056 21.646 21.646 21.646

0.3556 0.223 0.223 0.321 21.646 21.646 21.651

0.3584 0.456 0.456 0.649 21.645 21.645 21.645

: : : : : : :

以下 397点続くが省略する．

図 3.12: 3C-SiCの分散曲線．
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表 3.10: 4H-SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.554 0.051 0.056 0.112 5.705 5.718 5.913

0.5549 -0.05 -0.029 -0.018 5.711 5.724 5.907

0.5586 -0.395 0.242 0.673 5.722 5.728 5.922

0.5624 -0.204 0.492 1.111 5.72 5.772 5.947

0.5661 0.542 0.756 1.536 5.717 5.845 5.966

: : : : : : :

1.0478 0.548 0.847 1.654 5.781 5.863 5.978

1.051 -0.088 0.635 1.31 5.752 5.801 5.949

1.0543 -0.412 0.424 0.963 5.73 5.758 5.927

1.0575 -0.416 0.211 0.6 5.717 5.732 5.912

1.0608 -0.05 -0.029 -0.018 5.711 5.724 5.907

表 3.11: 4H-SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5486 0.056 0.06 0.065 5.671 5.695 5.899

0.5494 -0.104 -0.018 0.028 5.676 5.701 5.893

0.5531 -0.392 0.247 0.657 5.69 5.702 5.897

0.5568 -0.204 0.499 1.087 5.699 5.735 5.908

0.5606 0.536 0.766 1.504 5.7 5.806 5.926

: : : : : : :

1.0375 0.527 0.845 1.62 5.747 5.833 5.971

1.0407 -0.145 0.634 1.285 5.718 5.774 5.943

1.0439 -0.419 0.423 0.946 5.696 5.733 5.92

1.0472 -0.418 0.213 0.588 5.681 5.709 5.901

1.0504 -0.104 -0.018 0.028 5.676 5.701 5.893
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図 3.13: 4H-SiCの分散曲線．
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表 3.12: 6H-SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5356 0.051 0.052 0.088 4.175 4.208 4.321

0.5362 0.03 0.032 0.04 4.182 4.216 4.314

0.5399 -0.401 0.239 0.676 4.199 4.22 4.331

0.5436 -0.235 0.479 1.108 4.224 4.258 4.359

0.5473 0.527 0.734 1.525 4.24 4.345 4.383

: : : : : : :

1.0265 0.543 0.835 1.643 4.276 4.384 4.405

1.0297 -0.105 0.627 1.303 4.237 4.31 4.367

1.033 -0.413 0.419 0.96 4.208 4.257 4.339

1.0362 -0.413 0.211 0.601 4.189 4.226 4.32

1.0394 0.03 0.032 0.04 4.182 4.216 4.314

表 3.13: 6H-SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5303 0.055 0.056 0.059 4.011 4.1 4.268

0.5309 -0.047 0.038 0.04 4.015 4.106 4.262

0.5346 -0.393 0.241 0.66 4.02 4.123 4.27

0.5383 -0.226 0.481 1.082 4.035 4.175 4.283

0.542 0.519 0.739 1.488 4.059 4.261 4.305

: : : : : : :

1.0164 0.523 0.83 1.603 4.152 4.237 4.348

1.0196 -0.148 0.623 1.274 4.099 4.174 4.311

1.0228 -0.416 0.417 0.94 4.055 4.135 4.284

1.026 -0.412 0.211 0.589 4.026 4.113 4.268

1.0292 -0.047 0.038 0.04 4.015 4.106 4.262
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図 3.14: 6H-SiCの分散曲線．
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表 3.14: 2H-SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.604 -0.027 -0.024 0.026 7.684 7.694 17.141

0.6192 0.926 1.077 1.94 7.624 7.869 17.074

0.6345 1.976 2.276 3.713 7.509 8.394 16.88

0.6498 3.077 3.393 5.421 7.57 9.176 16.579

0.6651 4.227 4.427 6.985 8.008 10.118 16.206

: : : : : : :

1.0572 3.413 3.649 5.91 8.412 9.419 16.597

1.0704 2.592 2.726 4.474 8.116 8.683 16.83

1.0837 1.744 1.767 3.03 7.884 8.136 17.001

1.0969 0.729 0.876 1.6 7.737 7.803 17.106

1.1101 -0.027 -0.024 0.026 7.684 7.694 17.141

表 3.15: 2H-SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.598 -0.05 0.015 0.031 7.694 7.697 16.584

0.6132 0.919 1.067 1.905 7.634 7.869 16.522

0.6283 1.973 2.27 3.625 7.534 8.364 16.34

0.6434 3.064 3.39 5.287 7.6 9.106 16.057

0.6586 4.196 4.422 6.824 8.008 10.005 15.705

: : : : : : :

1.0468 3.399 3.632 5.742 8.401 9.334 16.076

1.0599 2.581 2.711 4.352 8.113 8.634 16.294

1.073 1.736 1.748 2.955 7.888 8.116 16.454

1.0861 0.699 0.873 1.572 7.744 7.801 16.551

1.0992 -0.05 0.015 0.031 7.694 7.697 16.584
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図 3.15: 2H-SiCの分散曲線．

熱振動効果を含む自由エネルギーのフィッティング

3C-SiCの自由エネルギーのフィッティングは温度Tを0,800,1200,1600,2000,2400,3000

と変化させ，自由エネルギーを求めた [図 3.16]．極小値を取るときの rの値が平衡
原子間距離 r0になる．図 3.16より，平衡原子間距離が増加していることが分かる．
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図 3.16: 3C-SiCの熱膨張の自由エネルギー．

4H,6H,2H-SiCの自由エネルギーのフィッティングは各温度における，エネルギー
局面を描く．まず，図 3.17は 4H-SiCの 1000Kの時の a軸，c軸を膨張させたとき
の振動の自由エネルギーである．Efixは膨張させない時の自由エネルギーである．
Eminは各温度の時の振動の自由エネルギーの極小値である．この自由エネルギー
の極小値を c/aを固定しない場合の自由エネルギーとする．図 3.17では膨張させ
ない時のエネルギーと振動の自由エネルギーの極小値では 0.9204160[kJ/mol]低く
なっている．
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図 3.17: 4H-SiCの 1000K時の c/aを変化させた振動効果を含み自由エネルギー．

図 3.18は 4H-SiCの 2000Kの時の a軸，c軸を膨張させた振動の自由エネルギー
である．Efixは膨張させない時の自由エネルギーである．Eminは 2000Kの時の振
動の自由エネルギーの極小値である．図 3.18では膨張させない時のエネルギーと
振動の自由エネルギーの極小値では 2.436058[kJ/mol]低くなっている．
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図 3.18: 4H-SiC2000K時の c/aを変化させた振動効果を含む自由エネルギー．

図 3.19は 6H-SiCの 1000Kの時の a軸，c軸を膨張させた振動の自由エネルギー
である．Efixは膨張させない時の自由エネルギーである．Eminは 1000Kの時の振
動の自由エネルギーの極小値である．図 3.19では膨張させない時のエネルギーと
振動の自由エネルギーの極小値では 0.992297[kJ/mol]低くなっている．
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図 3.19: 6H-SiC1000K時の c/aを変化させた振動の自由エネルギー．

図 3.20は 6H-SiCの 2000Kの時の a軸，c軸を膨張させた振動の自由エネルギー
である．Efixは膨張させない時の自由エネルギーである．Eminは 2000Kの時の振
動の自由エネルギーの極小値である．図 3.20では膨張させない時のエネルギーと
振動の自由エネルギーの極小値では 2.348668[kJ/mol]低くなっている．

41



図 3.20: 6H-SiC2000K時の c/aを変化させた振動の自由エネルギー．

図 3.21は 2H-SiCの 1000Kの時の a軸，c軸を膨張させた振動効果を含む自由エ
ネルギーである．Efixは膨張させない時の自由エネルギーである．Eminは 1000K

の時の振動効果を含む自由エネルギーの極小値である．図 3.21では膨張させない
時のエネルギーと振動効果を含む自由エネルギーの極小値では 2.432677[kJ/mol]

低くなっている．
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図 3.21: 2H-SiC2000K時の c/aを変化させた熱振動効果を含む自由エネルギー．

図 3.22は 2H-SiCの 1500Kの時の a軸，c軸を膨張させた振動効果を含む自由エ
ネルギーである．Efixは膨張させない時の自由エネルギーである．Eminは 1500K

の時の振動効果を含む自由エネルギーの極小値である．図 3.22では膨張させない
時のエネルギーと振動効果を含む自由エネルギーの極小値では 3.121269[kJ/mol]

低くなっている．

43



Efix

Emin

a

c

Fr
ee

 e
ne

rg
y 

[k
J/m

ol
]

図 3.22: 2H-SiC1500K時の c/aを変化させた熱振動効果を含む自由エネルギー．

線形熱膨張の比較

図 3.23の 3C-SiCの実験値は Z. Li and R. C. Bradt[7] の論文のデータを使用し
ている．線形熱膨張率 ϵ[％]を求めている．基準となる温度は 0[℃]とする．図 3.23

での計算値は 700[℃]付近では 0.027％程度実験値より縮んでいる．1000[℃]付近
でも高々0.030％程度の差しかない．
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図 3.23: 3C-SiCの線形熱膨張率の比較．

図 3.24の 4H-SiCの実験値は Z. Li and R. C. Bradt[8]の論文のデータを使用し
ている．基準となる温度は 0[℃]とする．図 3.24での計算値は 700[℃]付近では a

軸は 0.055％，c軸は 0.065％程度実験値より縮んでいる．1000[℃]付近でも高々a

軸は 0.072％，c軸は 0.092％程度の差しかない．
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図 3.24: 4H-SiCの線形熱膨張率の比較．

図 3.25 の 6H-SiCの実験値は Z. Li and R. C. Bradt[9]の論文のデータを使用し
ている．基準となる温度は 0[℃]とする．図 3.25での計算値は 700[℃]付近では a

軸は 0.055％，c軸は 0.072％程度実験値より縮んでいる．1000[℃]付近でも高々a

軸は 0.077％，c軸は 0.10％程度の差しかない．
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図 3.25: 6H-SiCの線形熱膨張率の比較．

熱膨張による体積の増加率

0K時の体積を基準として，温度による体積の増加率として計算された結果が図
3.26である．この図であきらかなように，4H，6H及び 2H-SiCがほぼ同値である
のに対し，3C-SiCの体積の増加率が極端に高くなっているのがわかる．
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図 3.26: SiC多形の体積増加率の温度依存性．

熱膨張を考慮した振動効果を含む自由エネルギー

図 3.27は 3C,4H,6H及び 2H-SiCの熱膨張を考慮した振動効果を含む自由エネル
ギーの温度依存性であるが，温度に対する各多形のエネルギー差がないことが分
かる．そこで，図 ??は 4H-SiCを基準にした，熱膨張を考慮した振動効果を含む
自由エネルギーの温度依存性を出したものである．熱膨張を考慮しない，一定体
積の結果と比べ，2Hと 6Hはほとんど変化はないが，3C-SiCが高温でより，不安
定化したことがわかる．これは，第 3.2の基底状態の E-V曲線の一次微分の傾き
から見られた，3C-SiCの硬さの上昇によるものと考えられる．
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図 3.27: SiC多形の熱膨張を考慮した振動効果を含む自由エネルギーの温度依存性．
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図 3.28: 4H-SiCを基準にとった場合の SiCの熱膨張を考慮した振動効果を含む自
由エネルギーの温度依存性．

3.4 E-V曲線からのSiC多形の自由エネルギー
VASPにより求めたE-V曲線のfitting関数から，体積弾性率，Debye温度，Debye

関数を求めて SiC多形の熱振動効果を含む自由エネルギーの体積依存性と温度に
よる体積の増加を求めた．計算には数式処理ソフトのMapleを用いた．4H-SiCを
例にとって，以下プログラム解説と共に説明していく．
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3.4.1 下準備

Mapleを用いる際に下準備として，プログラム上で利用するMapleのパッケー
ジの呼び出し．

restart;

with(Maplets[Examples]):

with(plots):

with(plottools):

with(stats):

with(LinearAlgebra):

with(linalg):

基本的に新しいシートの頭に打ち込んでもらいたい．この他にもたくさんあるが，
今回はこれだけのパッケージを呼び出せばよい．

3.4.2 体積弾性率

VASPで求めたスケールとエネルギーのデータとPOSCARファイルのprimitive

vectors と lattice coordinatesを取り出し，別々に listlist形式で保存する．

SiC_H4_data:=[[.9, -53.150058], [.925, -56.478669], [.95, -58.624952],

[.975, -59.799362], [1.0, -60.186773], [1.025, -59.941432],

[1.05, -59.189460], [1.075, -58.038976], [1.1, -56.574620]]:

pr:=[[3.089260627, 2.428372*10^(-10), 2.955363*10^(-10)],

[-1.544630243, 2.675378219, 3.072398*10^(-10)],

[1.815168130*10^(-7), 3.226965565*10^(-7), 10.10319970]]:

cood:=[[9.247*10^(-13), 9.367*10^(-13), -0.4581051102e-2],

[9.247*10^(-13), 9.367*10^(-13), .4954189489],

[.3333333300, .6666666700, .2454839734],

[.6666666700, .3333333300, .7454839734],

[-3.721*10^(-13), -3.770*10^(-13), .1829857237],

[-3.721*10^(-13), -3.770*10^(-13), .6829857237],

[.3333333300, .6666666700, .4336113539],

[.6666666700, .3333333300, .9336113539]]:

さらに，計算上必要となってくる格子定数，SiCあたりの原子数及び体積を求めて
いく．

a_SiC_H4:=evalf(sqrt(pr1[1]^2+pr1[2]^2+pr1[3]^2));

b_SiC_H4:=evalf(sqrt(pr2[1]^2+pr2[2]^2+pr2[3]^2));
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c_SiC_H4:=evalf(sqrt(pr3[1]^2+pr3[2]^2+pr3[3]^2));

3.089260627

3.089260624

10.10319970

SiC_H4_atom:=nops(cood)/2;

SiC_H4_atom := 4

pr1:=pr[1]:

pr2:=pr[2]:

pr3:=pr[3]:

beta:=abs(sin(arctan(pr2[2]/pr2[1])));

gam:=abs(sin(arctan(pr3[3]/sqrt(pr3[1]^2+pr3[2]^2))));

0.8660254167

1.000000000

V_SiC_H4:=evalf((a_SiC_H4*b_SiC_H4*c_SiC_H4*beta*gam)/SiC_H4_atom);

V_SiC_H4 := 20.87558634

ここで格子定数は [Å]であらわされており，したがって，体積は [Å
3
/SiC atoms]

である．
以上からも体積弾性率を求めるのは可能であるが，2.3章での体積弾性率の定義
式 (2.23)では，原子間距離 rの関数であるために，上記のパラメータを元に変数
変換していく．
まず，POSCARファイルの lattice coordinatesから Si-Cの第一近接の原子間距
離を求める．

dist:=[]:

for i from 2 to nops(cood) do

xx:=(Matrix(3,3,pr).Vector(cood[1])-Matrix(3,3,pr).Vector(cood[i]))[1]:

yy:=(Matrix(3,3,pr).Vector(cood[1])-Matrix(3,3,pr).Vector(cood[i]))[2]:

zz:=(Matrix(3,3,pr).Vector(cood[1])-Matrix(3,3,pr).Vector(cood[i]))[3]:

dist:=[op(dist),[evalf(sqrt(xx^2+yy^2+zz^2))]];

end do:

dist;

dist:=[[5.051599850], [3.008820364], [7.854142214],

[1.895024583], [6.946624433], [4.719071183], [9.700887486]]

op(dist[4]);

1.895024583
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原子間距離を表すdistの値は lattice coordinatesの性質上たくさんでてくるが，Si-C

第一近接の原子間距離だけを決定し，後の計算に用いる．
続いて元データから静止エネルギーの原子間距離依存性を求める．

SiC_H4_data:=[[.9, -53.150058], [.925, -56.478669], [.95, -58.624952],

[.975, -59.799362], [1.0, -60.186773], [1.025, -59.941432],

[1.05, -59.189460], [1.075, -58.038976], [1.1, -56.574620]]:

for i from 1 to nops(SiC_H4_data) do

SiC_H4_data[i,1]:=SiC_H4_data[i,1]*op(dist[4])*1.89:

SiC_H4_data[i,2]:=SiC_H4_data[i,2]*(1.602176/21.79872)/SiC_H4_atom:

end do:

SiC_H4_data:=[[3.223436816, -.9766140778], [3.312976727, -1.037776163],

[3.402516639, -1.077213376], [3.492056550, -1.098792757],

[3.581596462, -1.105911301], [3.671136374, -1.101403245],

[3.760676285, -1.087586017], [3.850216197, -1.066446269],

[3.939756107, -1.039539229]];

ただし，プログラム中の x軸に対応するデータに対する×1.89は [Å] → [a.u.]，y

軸に対する×(1.602176/21.79872)は [eV] → [Ry]に単位変換を行っている．
以上の結果を最少二次近似法を用いて fittingを行った [図 3.29]．

data_SiC_H4:=convert(transpose(convert(SiC_H4_data,array)),listlist):

fit1:=fit[leastsquare[[x,y], y=c0+c1*x+c2*x^2+c3*x^3+c4*x^4,

{c0,c1,c2,c3,c4,c5}]](data_SiC_H4):

fit_SiC_H4:=unapply(rhs(fit1),x);

fit_SiC_H4:=22.17658789+(-1)*12.79603777*x+.6118547217*x^2+

.6246596016*x^3+(-1)*0.8508631729e-1*x^4

poi_SiC_H4:=pointplot(SiC_H4_data):

p_SiC_H4:=plot(fit_SiC_H4(x),x=xmin_SiC_H4..xmax_SiC_H4):

display(poi_SiC_H4,p_SiC_H4);
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図 3.29: 4H-SiCの静止エネルギーの原子間距離依存性．

いよいよ体積弾性率を求めていく．体積を rの関数として求めてから，定義式
(2.23)の通りにすると

VV:=unapply(solve(op(dist[4])*1.89*x=a_SiC_H4,x)*x

*solve(op(dist[4])*1.89*x=b_SiC_H4,x)*x

*solve(op(dist[4])*1.89*x=c_SiC_H4,x)

*x*beta*gam*1.89^3/SiC_H4_atom,x);

3.079201264*x^3

dV:=unapply(1/diff(VV(x),x),x):

plot(BB(x),x=1..4);

で表される [図 3.30]．ただし，体積弾性率を [Ry/a.u.3] → [eV/Å3] → [Gpa] →
[kbar]へと単位変換している事に注意する．
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図 3.30: 4H-SiCの体積弾性率の原子間距離依存性．

また，基底状態での平衡原子間距離における体積弾性率は以下のようになる．

r0:=fsolve(diff(fit_SiC_H4(x),x)=0,x=3..4);

r0:=3.584989663

BB(r0);

2263.982950

3.4.3 Debye温度

Debye温度，式 (2.32)を求めるプログラムである．

M:=40.1:
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thetaD:=unapply(41.63*((r*BB(r))/M)^(1/2),r);

thetaD(r0);

592.5730315

ただし，Mは原子量である (Si=28.09,C=12.01[10])．θDの原子間距離依存性は図
(3.31)である．
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図 3.31: 4H-SiCの θDの原子間距離依存性．

3.4.4 Debye関数

Debye関数を求めるプログラムとそれをプロットした [図 3.32]．

f1:=unapply(exp(x)*x^4/(exp(x)-1)^2,x):
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Debye:=unapply((3/y^3)*Int(f1(x),x=0..y),y):

Df:=unapply(Re(evalf(Debye(thetaD(r)/T))),r,T):

plot(Df(r,300),r=3.2..4);

r [a.u.]

図 3.32: Debye関数．

3.4.5 熱振動効果を含む自由エネルギー

静止エネルギーの E-V曲線，体積弾性率，Debye温度，Debye関数より自由エ
ネルギーの式が求まる．以下がそのプログラムであるが，[Ry] → [eV]へ単位変換
している．

Ry:=2.17987*10^(-18):

kb:=1.38026*10^(-23):
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eq1:=unapply((kb/Ry)*T*(Df(r,T)-3*ln(1-exp(-thetaD(r)/T)))

-(9/8)*(kb/Ry)*thetaD(r),r,T);

g:=(fit_SiC_H4(r)-eq1(r,T))*(21.79872/1.602176):

FF:=unapply(g,r,T):

3.4.6 4H-SiCの熱振動効果を含む自由エネルギーのプロット

温度Tを 1,100,200...2000と変化させ，熱振動効果を含む自由エネルギーを求め
た．図 3.33は求めた自由エネルギー曲線の温度T=1,800,1500だけをプロットして
いる．ただし，x軸を原子間距離 [a.u.]から体積 [Å

3
]へと変換している．この極小

値をとるときのVの値がその温度での体積V0を示す．図 3.33から見て取れるよ
うに，温度が上がるにつれて体積が増加しており，熱膨張が再現されていること
がわかる．

xmin:=15.21830244:

xmax:=27.78540542:

xmi:=3:

xma:=3.8:

tmp0:=[]:

plist:=[]:

poilist:=[]:

for i from 100 to 2000 by 100 do

tmp||i:=[]:

end do:

for i from xmi to xma by 0.2 do

tmp0:=[op(tmp0),[3.067567570*(i/1.89)^3,evalf(FF(i,1))]]:

end do:

data0:=convert(transpose(convert(tmp0,array)),listlist):

fit1:=fit[leastsquare[[x,y], y=c0+c1*x+c2*x^2+c3*x^3+c4*x^4,

{c0,c1,c2,c3,c4,c5}]](data0):

fit0:=unapply(rhs(fit1),x):

plist:=[op(plist),[plot(fit0(x),x=xmin..xmax)]]:

poilist:=[op(poilist),[pointplot([fsolve(diff(fit0(x),x)=0,x=18..24),

fit0(fsolve(diff(fit0(x),x)=0,x=18..24))])]]:

for i from 100 to 2000 by 100 do

for j from xmi to xma by 0.2 do

tmp||i:=[op(tmp||i),[3.067567570*(j/1.89)^3,evalf(FF(j,i))]]:
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end do:

data||i:=convert(transpose(convert(tmp||i,array)),listlist):

fit1:=fit[leastsquare[[x,y], y=c0+c1*x+c2*x^2+c3*x^3+c4*x^4,

{c0,c1,c2,c3,c4,c5}]](data||i):

fit||i:=unapply(rhs(fit1),x);

plist:=[op(plist),[plot(fit||i(x),x=xmin..xmax)]]:

poilist:=[op(poilist),[pointplot([fsolve(diff(fit||i(x),x)=0,x=18..24),

fit||i(fsolve(diff(fit||i(x),x)=0,x=18..24))])]]:

end do:

display(plist[1],poilist[1],plist[9],poilist[9],

plist[16],poilist[16],view=[xmin..xmax,-15.6..-14.4]);
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図 3.33: 4H-SiCの熱振動効果を含む自由エネルギー．
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図 3.33より，自由エネルギーの温度依存性をプロットする [図 3.34]．
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図 3.34: 4H-SiCの自由エネルギーの温度依存性．

3.4.7 温度による体積の増加率

図 3.33でT=1のときの体積V0を基準として，温度による体積の増加率を求め
た [図 3.35]．

60



Temperature [K]

体
積
増
加
率

図 3.35: 4H-SiCの体積増加率の温度依存性．

3.5 SiC多形の自由エネルギー計算の比較
擬調和振動子近似である phonon-DOS法とE-V曲線からの簡便法で，熱振動効
果を含む自由エネルギー計算を 3C，4H，6H及び 2H-SiCに適用し行った．その結
果を比較する．

3.5.1 熱膨張による体積増加率の比較

図3.36は (a):3C-SiCと (b):2H-SiCの0K時の体積を基準とした，熱膨張による体
積増加率の温度依存性の比較である．黒の破線が実験結果，赤の実線がphonon-DOS

法での計算結果，青の実線がE-V曲線からの簡便法での計算結果である．3C-SiC

の実験結果は Z. Li and R. C. Bradt[7]の線形熱膨張率の論文のデータから，体積
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増加率に計算し直した結果を用いた．3C-SiCで，実験結果と簡便法での計算結果
を比較してみると，一番大きな差を取ってみても，たかだか 0.002%程度の差しか
ない．また，phonon-DOS法との比較ではそれ以下の差であり，簡便法を用いたに
しては精度よく計算できたと考えられる．また，2H-SiCの phonon-DOS法とE-V

曲線からの簡便法での熱膨張による体積増加率の比較でも，良い一致が得られた
と考えられる．

(a)
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]

Temperature [K]
(b)

図 3.36: (a):3C-SiC, (b):2H-SiCの熱膨張による体積増加率の比較．

図 3.37は (a):4H-SiCと (b):6H-SiCの 0K時の体積を基準とした，熱膨張による
体積増加率の温度依存性の比較である．黒の破線が実験結果，赤の実線がphonon-

DOS法での計算結果，青の実線が E-V曲線からの簡便法を用いて求めた計算結
果である．4H-SiCの実験結果は Z. Li and R. C. Bradt[8]の論文のデータから，
6H-SiCの実験値はZ. Li and R. C. Bradt[9]の論文のデータから体積増加率に計算
し直した結果を用いた．実験結果と簡便法での計算結果を比較してみると，4Hと
6H-SiC共に 3C-SiCと同じく，一番大きな差を取ってみても，たかだか 0.002%程
度の差しかない．
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図 3.37: (a):4H-SiC, (b):6H-SiCの熱膨張による体積増加率の比較．

図3.38は (a):phonon-DOS法と (b):E-V曲線からの簡便法を用いて求めた，3C,4H,6H

及び 2H-SiCの 0K時の体積を基準とした，熱膨張による体積増加率の温度依存性
である．phonon-DOS法と簡便法の体積増加率の温度依存性の各多形の傾向を見
比べてみると，2H-SiCだけが違う傾向を示した．しかし，少し確認しずらいが他
の多形の傾向では，両方ともに 4Hと 6H-SiCの体積増加率が等しく，その二つの
多形に比べて 3C-SiCの体積増加率が大きくなっていることまで一致した．
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図 3.38: (a):phonon-DOS法，(b):E-V曲線からの簡便法での熱膨張による体積増
加率の比較．

3.5.2 SiC多形の熱膨張を考慮した振動効果を含む自由エネルギー

図 3.39がE-V曲線からの簡便法を用いて求めた，3C,4H,6H及び 2H-SiCの熱振
動効果を含む自由エネルギーの温度依存性である．
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図 3.39: a:SiC多形の熱振動効果を含む自由エネルギーの温度依存性．b:4H-SiCを
基準とした SiC多形の熱振動効果を含む自由エネルギーの温度依存性．

この結果は各温度での安定な体積を元に得られた結果であり，比較対象は図3.27

と図 3.28である．一見して，phonon-DOS法の結果と違う事がわかる．それは基底
状態のエネルギーにわずかであるが差があるからであり，構造計算時の計算精度で
の誤差であると考えられる．そこで，次に自由エネルギーの変化量の温度依存性を
比較するために，基底状態におけるエネルギーの値を phonon-DOS法の値を用い
てプロットした [図 3.40]．この図と図 3.28からわかるように，6H-SiCから 4H-SiC

への相変態点の温度が等しく，ほぼ同値の変化量を示していることがわかる．
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図 3.40: 自由エネルギーの変化量の温度依存性．
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第4章 ZrCr2Laves相の各型の計算
物性

SiC多形において，E-V曲線からの簡便法は，より精度の高い phonon-DOS法
と比較してみても，熱膨張と自由エネルギーの変化量共に良い一致を示したこと
により，適用可能であると考えられる．しかし，この簡便法が他の材料でも有効
であるのかを検証する必要がある．そこで，次の比較対象として，ZrCr2Laves相
についても同様に，phonon-DOS法で熱膨張を考慮しない熱振動効果を含む自由
エネルギー計算と E-V曲線からの簡便法での熱振動効果を含む自由エネルギーを
計算し，比較した．

4.1 ZrCr2Laves相の各型 [11]

まず，ZrCr2Laves相について，軽く説明しておきます．Laves相とは，2種類の
金属 A,Bからできる金属間化合物で AB2型の組成比を持ち，原子半径比が 1.2:1

となる一連の化合物です．また，金属間化合物の中で最も数が多いグループであ
り，主な結晶多形として，MgCu2(C14)型，MgZn2(C15)型, MgNi2(C36)型とい
う３つの構造を持ちます．図 4.1は Laves相の各型を模式的に表した図になりま
す．ユニットセルあたりの原子数は C14型では 12原子，C15型と C36型では 24

原子となっています．また，C14型と C36型は六方構造をとり，C15型は立方構
造を取ります．Laves相の特徴を用いた例をあげると，ニッケル金属水素化合物
Zr(V,Mn,Ni)2の Laves相は，ニッケル金属水素電池として利用できる次世代金属
の一つとして期待されています．しかしながら現在分かっている Laves相の原子
モデルと計算結果は，一般的な安定性を述べるのにはまだ不十分である．
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C14 C15 C36

図 4.1: Laves相の各型の構造の模式図．

また，図 4.2は pavluらの実験 [12]によって求められた，ZrCr2Laves相の縦軸が
温度で，横軸が Zrの組成となる，Zr-Cr二元系状態図です．各型の温度による相
安定が求められており，およそ 1000K∼1800Kの比較的低温側では C15型が安定
であり，1800K∼1900Kの中温域では C36型，およそ 1900K∼1950Kでは C14型
が安定であるとなっています．
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図 4.2: Zr-Cr二元系状態図．

4.2 phonon-DOS法とE-V曲線からの簡便法での計
算結果の比較

今回は，ZrCr2Laves相の各型に対し，phonon-DOS法により，熱膨張を考慮し
ない熱振動効果を含む自由エネルギー計算とE-V曲線からの簡便法を用いた，熱
膨張を考慮した，熱振動効果を含む自由エネルギー計算を行った．phonon-DOS法
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において熱膨張を考慮しなかったのは，対象とした，ZrCr2の各型は一つのスケー
ル計算だけでも計算量が多く，時間がかかり過ぎてしまうからである．

4.2.1 体積膨張率の簡便法と実験値比較

熱膨張を考慮していないために，phonon-DOS法では体積膨張率を計算するこ
とができなかったので，簡便法との比較は，A. Kellowらの論文 [13]の実験結果
(C15型)と比較した [図 4.3]．(a)がKelloらの実験結果 (C15型)による体積膨張率
の温度依存性であり，(b)がE-V曲線からの簡便法から求めた体積膨張率の温度依
存性である．計算式は式 2.19を用いた．低温での温度による体積膨張率の増加の
傾向は等しいととれるが，高温側とオーダーに関してはあまり良い一致が見られ
ず，精度よく計算できなかった．
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図 4.3: (a):Kellowらの実験結果 (C15型)，(b)E-V曲線からの簡便法から求めた体
積膨張率．

4.2.2 phonon-DOS法とE-V曲線からの簡便法を用いた計算結果

の変化量の比較

今回の phonon-DOS法では熱膨張を考慮せず，有限温度における相安定性を述
べるには不十分な計算結果ではあるが，低温で安定なC15型からおよそ 1100Kで
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C14型へと相変態が起こっており，これはKelloらの実験結果の一部を再現できた．
しかし，E-V曲線からの簡便法の計算結果では，各多形に全く相変態が見られず，
不十分な結果しか得られなかった．
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図 4.4: (a):phonon-DOS法，(b)E-V曲線からの簡便法から求めた自由エネルギー
の変化量．
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第5章 総括

SiC多形と ZrCr2Laves相の各型に対し，phonon-DOS法とE-V曲線からの簡便
法を用いて，振動効果を含む自由エネルギー計算を行った．そして，より精度の
高い phonon-DOS法と比較することで，簡便法の信頼性を調べた．

1. SiC多形の体積増加率の温度依存性は実験結果，phonon-DOS法の両方で簡便
法を用いたにしては，良い一致を示した．

2. SiC多形の自由エネルギーの変化量は低温では 4H-SiCが安定，中温域から高
温側では 6H-SiCが安定となる，相変態を簡便法でも再現でき，精度よく計
算できたと考えられる．

3. ZrCr2Laves相の各型の体積膨張率，自由エネルギーの変化量の両方ともに簡便
法では，実験結果を再現できずに，計算精度は不十分であると考えられる．

今回の新しい手法は，SiCのような比較的簡単な系に対しては適用可能である．
しかし，ZrCr2Laves相の各型のように，複雑な系では簡易な見積もりをするのに
は有効であるが，適用可能性を検証する必要がある．
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付 録A MedeAによるphononの
使用法

A.1 手順
1. 　MedeAを用いてセルを作る．

2. 　第一原理計算ソフトVASPを用いて原子にかかる力を求める．

3. 　かかった力のデータをPHONONに入力しフォノン分散関係，状態密度を計
算する．

このような手順によりフォノン分散曲線，状態密度を求める．具体的には 3C, 4H,

6H及び 2H-SiCの格子のエネルギーが最安定となるときの計算について述べる．

A.2 セルの作成

A.2.1 モデルウィンドウを開く

Fileでは新しいファイル作成したり，すでにあるファイルを読み込んだりするこ
とができる．ここでは，新しいファイルを作成する．MedeAのメインメニューか
ら「File > New」を選択する．そしたら，周期境界を示すボックスのみが表示さ
れた「Untitled」の名前がついたウィンドウが表示される．

A.2.2 対称性の設定

1. 　対称性の情報を入力する．

2. 　MedeAのメインメニューから「Edit > Edit structure... 」を選択する．ま
たは，モデルウィンドウ上でマウスを右クリックし，「Edit Symmetry... 」を
選択する．

3. 　「Strucute Editor」が表示される．現在の対称性はP1となっている．「Space-

group:」の右にある
...
のボタンをクリックする．3C-SiC の対称性はF-43m

4H, 6H及び 2H-SiCの対称性は P63mc　なので，「Primitive 」のリストの中
から選択して OK のボタンをクリックする．
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A.2.3 格子定数の設定

1. 　続いて，格子定数を変更する．デフォルトでは，新しい格子の定数は a=b=c=10

Å, α=β=γ=90°になっている．

2. 　MedaAのメインメニューから「Edit > Edit strucute」を選択し，「Structure

Editor」を開いたら，「Cell」タブを選択する．または，モデルウィンドウ上
では右クリックし，「Edit Cell...」を選択する．

3. 　 3C-SiCは対称性が F-43mと規定されているため，a軸の長さのみ変更可能
になっている．3C SiCの格子定数はおよそ 4.36Åなので，A:の右のボック
スに 4.36と入力する．

表 A.1: 3C-SiCの格子定数の例．
A B C α β γ

4.36 4.36 4.36 90 90 90

4. 　 4H,6H及び 2H-SiCは対称性がP63mcと規定されているため，a,c軸の長さの
み変更可能になっている．4H-SiCのa,c軸の格子定数はおよそ3.08Å，10.05Å

なので，A:の右のボックスに 3.08 ，C:の右のボックスに 10.05と入力する．

5. 　 6H-SiCの a,c軸の格子定数はおよそ 3.08Å，15.12Åなので，A:の右のボック
スに 3.08 ，C:の右のボックスに 15.12と入力する．

6. 　 2H-SiCの a,c軸の格子定数はおよそ 3.08Å，5.02Åなので，A:の右のボック
スに 3.08 ，C:の右のボックスに 15.12と入力する．

表 A.2: 4H-SiCの格子定数の例．
A B C α β γ

3.08 3.08 10.05 90 90 120
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表 A.3: 6H-SiCの格子定数の例．
A B C α β γ

3.08 3.08 15.12 90 90 120

表 A.4: 2H-SiCの格子定数の例．
A B C α β γ

3.08 3.08 5.02 90 90 120

7. 　画面上の周期境界を表す黒い線上にマウスカーソルを持っていくと，MedeA

ウィンドウの下部に表示されて，格子定数がわかる．

4H SiCの場合

Cell edgers: 3.0800 3.0800 10.0500 Cell angles: 90.00 90.00 120.00

A.2.4 原子の入力

1. 　MedeAのメニューから 「Edit ¿ Edit structure... 」を選択し，「Structure

Editor 」を開いたら，「Add Atom」タブを選択する．または，マウス右ク
リックから「Add Atom..」を選択し，Structure Editor を開く．

2. 　まず，C原子を挿入する．Element 部分にはデフォルトでCが入っているの
で，そのまま SiCの Cを挿入していく．Si原子はキーボード入力で Siと変
更するか，その右側にあるアイコンをクリックして，周期律表を開きSiを選
択する．

表 A.5: 3C-SiCの原子位置の例．
Name X Y Z

Si 0 0 0

C 0.25 0.25 0.25
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表 A.6: 4H-SiCの原子位置の例．
Name X Y Z

Si 0 0 0

Si2 0.33333 0.66667 0.25

C 0 0 0.17

C2 0.33333 0.66667 0.43750

表 A.7: 6H-SiCの原子位置の例．
Name X Y Z

Si 0 0 0

Si2 0.33333 0.66667 0.66667

Si3 0.33333 0.66667 0.33333

C 0 0 0.125

C2 0.33333 0.66667 0.45833

C3 0.33333 0.66667 0.79167

表 A.8: 2H-SiCの原子位置の例．
Name X Y Z

Si 0.33333 0.66667 0.37480

C 0.33333 0.66667 0

A.3 VASPの計算

A.3.1 計算設定

1. 　SiCの構造の最適化を計算する．MedeAメインメニューから「Tools > VASP.4.6」
を選択する．しばらくするとメインメニューにVASP.4.6が追加されるので，
「VASP.4.6 > RUN 」を選択する．

2. 　Calculationタブで以下の設定を行う．

・Type of calculationを Single Pointから Structure Optimizationに変更する．
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・Structure Optimization Parameters の 3 つのチェックボックス全てをチェッ
クする．

・Title は 4H-SiCなら 4H-SiCなどと入力するとよい．

・設定が終わったらRunボタンをクリックする．

A.3.2 計算実行

1. 　キューとプライオリティの指定を行う．

2. 　キューは takeda3と takeda4があり，お互い 4つの Jobを実行することがで
き，それ以上の Jobを実行すると待ち状態 (pending)になる．また両方で空
いているところに Jobを投げてくれる allがある．

3. 　プライオリティは優先度のことであり，数を多くすると優先度が上がり，小
さくすると優先度が下がる．デフォルトでは 5になっている．

4. 　設定が終わったらRunボタンをクリックする．

A.3.3 計算結果

1. 　MedeAメインメニューの「Job Control > View and Job Control 」を選択
する．しばらくすると，ウェブブラウザが起動し，ジョブ制御画面が現れる．

2. 　黒いバーの中あるいはパイパーリンクされている Jobs をクリックすると，
ジョブー覧表が表示される．

3. 　ジョブの番号が割り当てられている．Statusの部分には現在のジョブの状態
が分かる．Status部分には以下の状態が存在する．

4. 　 Statusが finishedになった番号をクリックする．

5. 　Available Output Filesの一番の上のファイル Job.outをクリックする．これ
のファイルが計算のサマリになる．

6. 　 Job.outファイルの中には計算条件，計算結果 ( 構造，エネルギー，力，圧
力，計算時間 )に関する情報が収められている．構造最適化計算を行った場
合は計算前後の構造についての情報が入っている．構造最適化の結果，元の
格子からわずかに格子が収縮した状態で安定構造が求まっている．
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A.4 Phononの計算
1. 　構造最適化計算の結果得られた安定構造はデータベースに収められており，

モデルウィンドウで開くことができる．MedeAのメインメニューから「File

> Open 」を選択し Previous Dalculationを選択する．

2. 　これまでの計算に使用した構造の一覧が表示されるので「minimized: 4-SiC」
などの minimizedどついている項目を選択し,[insert >> ] ボタンをクリック
すると，「Available」から「Curennt」覧に移動する．OKボタンをクリック
すると，結晶が表示される．

3. 　MedeAメインメニューから「Tools > Phonon」を選択する．しばらくする
とメインメニューに Phononが追加されるので，「Phonon > RUN 」を選択
する．

4. 　Phonon Simulationでは特に設定を変えず，Titleを自分のわかりやすいよう
に変更するだけでよい．Runポタンをクリックし計算を開始させる．

5. 　計算実行は A.3.2を参照し行う．ただし，Jobが多く存在するためにキュー
の設定には allを選ぶとよい．

A.5 phononの計算結果
1. 　A.3.3と同様に Statusが finishedになった番号をクリックし，
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付 録B VASPの計算ファイルの
ソース

全てのファイルは 4H-SiCをMedeAからVASP計算して作成されたものである．
ただし，このファイルはE-V曲線を作成する為に作成したため，B.2の計算設定で
の Structure Optimization Parametersの 3つのチェックボックスには一つもチェッ
クを入れていない．

B.1 INCARファイル
# SCF input for VASP

# Note that VASP uses the FIRST occurence of a keyword

SYSTEM = 4H-SiC(hideki)

PREC = Normal

ENCUT = 400.000

IBRION = -1

NSW = 100

ISIF = 3

ALGO = Normal (blocked Davidson)

NELM = 60

NELMIN = 2

EDIFF = 1.0e-05

EDIFFG = -0.02

VOSKOWN = 1

NBLOCK = 1

ISPIN = 1

INIWAV = 1

ISTART = 0

ICHARG = 2

LWAVE = .FALSE.

LCHARG = .FALSE.
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ADDGRID = .FALSE.

ISMEAR = 1

SIGMA = 0.2

LREAL = .FALSE.

RWIGS = 1.11 0.77

・PREC

・ENCUT

・IBRION

・NSW

B.2 KPOINTSファイル
Automatic mesh

0

Monkhorst Pack

5 5 2

0. 0. 0.

の手順 1の後に現れるウィンドウで，SCFのタブの中の Spacing of k-pointsで設
定を行える．内容は k点のサンプリングをMonkhorst Pack法とよばれる空間群
の対称性を考慮した方法で，上記では x,y軸に 5分割，z軸に 2分割するとなって
いる．

B.3 POSCARファイル
4H-SiC(hideki)

1.000000000000000

3.0892606272496720 0.0000000002428372 0.0000000002955363

-1.5446302432040640 2.6753782186594290 0.0000000003072398

0.0000001815168130 0.0000003226965565 10.1031997017174300

4 4

Direct

0.0000000000009247 0.0000000000009367 -0.0045810511016330

0.0000000000009247 0.0000000000009367 0.4954189488983671

0.3333333299999814 0.6666666699999769 0.2454839734400882

0.6666666699999773 0.3333333299999812 0.7454839734400881
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-0.0000000000003721 -0.0000000000003770 0.1829857237132894

-0.0000000000003721 -0.0000000000003770 0.6829857237132895

0.3333333299994701 0.6666666699994592 0.4336113539482572

0.6666666699994660 0.3333333299994633 0.9336113539482572

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

0.00000000E+00 0.00000000E+00 0.00000000E+00

MedeAにより作成された，構造の原子位置を与えるデータとなっている．一行
目がMedeAで名付けたファイルの名前である．次行はスケールの倍率をあらわし
ます．その次の三行が重要な要素となり，この原子を構成する空間の単位ベクト
ルを表しており，行列式を用いると，この構造の体積を示します．
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